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Section 1

Introduction
Welcome to the IDEA Tutorial.

IDEA (originally an acronym for Interactive Data Extraction and Analysis)
provides auditors, accountants, and systems and financial professionals
with the ability to display, read, analyze, manipulate, sample, and extract
data from data files from almost any source - mainframe to personal
computers, including reports printed to a file. IDEA extends your reach by
providing unique functions and features not found in generic software.

This tutorial covers the functionality of IDEA and IDEA Server.

Throughout the tutorial, the above products are referred to solely as IDEA
unless otherwise specified. In addition, the images used throughout this
tutorial may not necessarily reflect what you see on your screen depending
on the edition of IDEA you are using.

Additional
Resources

There is extensive online help available for all modules, including step-by-
step walk-throughs of tasks. In order to view the online help, you require
Microsoft Internet Explorer 9.0 or higher. You may also visit the CaseWare
Analytics website at www.casewareanalytics.com for additional
information such as tips and hints, frequently asked questions (FAQs), and
technical information.

Feedback Your feedback is important to us. Send your documentation-related
comments to IDEAdocumentation@caseware.com.

http://www.casewareanalytics.com/
http://www.casewareanalytics.com/
http://www.casewareanalytics.com/
mailto:IDEAdocumentation@caseware.com


Section 2

IDEA Overview
IDEA combines considerable analysis power with an extremely user-friendly
Windows environment. This versatile tool is useful for any type of file
interrogation and allows users to:

l Import data from a wide range of file types.

l Create custom views of data and reports.

l Perform analyses of data, including calculation of comprehensive
statistics, gap detection, duplicate detection, summaries, and aging.

l Perform calculations.

l Select samples using several sampling techniques.

l Match or compare different files.

l Create pivot tables for multi-dimensional analysis.

l Automatically generate a complete history that documents the analysis.

l Record, create, and edit macros with IDEAScript (a customizable VBA-
compatible scripting tool) and Visual Script.

l Conduct exception testing of unusual or inconsistent items using simple
or complex criteria.

IDEA has built-in @Functions for arithmetic, text, time, and date criteria,
including many financial @Functions. These @Functions perform operations
such as date, arithmetic, financial and statistical calculations, and text
searches.

Desktop Projects Desktop projects are stored either locally on your computer or on a shared
network location (for instance, a Managed project in IDEA Server Only
Mode). If Desktop projects are stored on a network drive, you must have
permission to write to the network drive.
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You can create the following two types of Desktop projects:

Project Description

Managed Within C:\Users\Your USERID\Documents\My IDEA
Documents\IDEA Projects.

Note: This is the default location. The location for
Managed project may be set to a local or network user-
defined folder.

Can be linked to IDEA Server projects

External Outside C:\Users\Your USERID\Documents\My IDEA
Documents\IDEA Projects
Can be linked to IDEA Server projects
Can point to pre-IDEA Version Nine Working Folders

When you first launch IDEA, you have access to two default Managed
projects: Samples and Tutorial. The Samples and Tutorial projects contain
all the files required to complete the exercises in this guide, the Report
Reader Tutorial, and the Advanced Statistical Methods Case Study. The
files are also used in the Language Browser examples.

IDEA Server
Projects

While an IDEA Server project is identical in function to a Desktop project,
there are several key differences between the two:

l Location: The location of an IDEA Server project is determined by the
IDEA Task Management Server.

l Creation: An IDEA Server project can only be created by an IDEA
Server Team Leader.

l Access: A basic user simply has rights to access projects to which they
have been assigned by an IDEA Server Team Leader.

The Association
Between Desktop
and IDEA Server
Projects

When linking Desktop and IDEA Server projects, keep the following
information in mind:

l When connecting to IDEA Server, the IDEA Server project that
becomes active will become linked to the active Desktop project. From
then on, every time you work in that Desktop project, IDEA will
automatically connect to its associated IDEA Server project.

l If you change your Desktop project, the connection will change to the
IDEA Server project associated with it, if a connection was previously
made.

l If you have a Desktop project and its associated IDEA Server project
open and you change the IDEA Server project through the Project
Properties dialog box, the IDEA Server project you link to will become
associated with the current Desktop project.

l Associations between Desktop projects and IDEA Server projects will
always remain as defined unless you manually change the association
through the Project Properties dialog box.
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l You can have one IDEA Server project associated with several Desktop
projects, however, you cannot have one Desktop project associated with
several IDEA Server projects.





Section 3

IDEA Windows and Toolbars
IDEA uses the following primary windows:

l Database window

l Properties window

l File Explorer window

l Library window

l Fly-Out windows

l IDEAScript window

l Dashboard window

Database Window The Database window lets you view the fields contained within a database.
Although multiple databases may be open at one time, each database is
opened in a separate Database window and the name of the active database
is displayed on the IDEA title bar.
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Properties Window Each database has several properties associated with it that are accessed
from the Properties window.

These properties are:

Property Description

Data Used to view the data in the file in a spreadsheet-like format with
field names as column headings and record numbers as row
numbers.

History Used to view the history of all operations performed on the file.
Each database has its own separate History.

Field
Statistics

Used to view the statistics for Numeric, Date, and Time fields in
the active database.

Control
Total

Used to display the sum of a selected Numeric field for
reconciliation purposes.

Criteria Used to isolate records that satisfy entered criteria.

Results Used to view the Results output for certain tasks.

Indices Used to switch between created index orders, delete index orders,
re-generate index orders, and remove all applied index orders from
the active database.

Comments Used to add comments to the active database. It is also used by
IDEA to display warningmessages related to the active database.
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File Explorer
Window

The File Explorer window displays all of the IDEA databases in a project in a
tree or a sorted view. If you have access to IDEA Server, the File Explorer
window becomes a horizontal or vertical split screen between Desktop
Project and IDEA Server Project.

The File Explorer window can be resized to show the full details of a
database, including the database name, the number of records, the size, the
date the database was last modified, and the date the database was created.
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The File Explorer also has a toolbar from where you perform such actions as
creating a sub-folder, changing the display from sorted to tree view,
refreshing the list of databases, and renaming, flagging, or deleting
databases.

Library Window In IDEA, a Library is a repository of files. Each Library in IDEA contains
Library groups in which you can organize the files associated to the project.

When a project is created, IDEA creates Library sub-folders that let you
organize all associated project files. The Library window in IDEA displays
these sub-folders as system Library groups and lists the files contained in
the groups. The groups in the Library are Custom Functions, Equations,
Exports, Import Definitions, Macros, Other, Results, Source Files, and
Visualization.

For each file in the Library, you can view the file size and the date the file
was last modified.
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From the Library window, you can perform such actions as creating custom
Library groups, deleting files, running macros, and copying files to another
Library.

There are three separate libraries available in IDEA:

Library Description

Corporate
Library

The Corporate Library is a repository of files on IDEA Server
compiled by IDEA Server Team Leaders. The Corporate Library
contains the standard system Library groups. Team Leaders can
add files to these system Library groups or create new custom
Library groups. Users that are connected to IDEA Server can
copy files from the Corporate Library to their current Desktop
project.

Note: The Corporate Library is only displayed if you are
connected to IDEA Server.

Local
Library

The Local Library is a repository of files on your local drive that
you use to share files with all your Desktop projects. The Local
Library is always available when you access IDEA. The Local
Library folder is created when you install IDEA and can be found
at C:\Users\YOUR USERID\Documents\My IDEA Documents.

Current
Project
Library

The Current Project Library displays the associated files for the
active Desktop project. If the Desktop project is linked to an
IDEA Server project, the associated server files for the linked
IDEA Server project are also displayed.
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Fly-out Windows The following fly-out windows are available as tabs at the base of the
application window:

Fly-out
Windows

Description

Running Tasks The Running Tasks fly-out window provides you with the
progress information for a particular task that is running.

Search Results IDEA displays the results of a search in the Search Results
fly-out window. Within this window, new searches overwrite
old ones. From the right-click menu in the Search Results
window, you can re-run the search (as is or make
refinements) or print the results. Youmay sort the results by
double-clicking any of the columns within the Search Results
window. A directional arrow appears in the field header to
indicate the sort order (ascending or descending). IDEA
Server allows multiple users to be searching the same
database simultaneously without the risk of overwriting
another user's search results.

The fly-out windows can be pinned down by clicking the push pin icon in the
upper-right corner of the window.

IDEAScript Window IDEA includes a development tool known as IDEAScript for creating macros
to extend the functionality of IDEA. An IDEAScript can be recorded, written
from scratch, or a combination of both. The IDEAScript code is generated or
written in the IDEAScript window. This window has a toolbar providing
access to a number of commonly used options and tools to assist with
writing, editing, and debugging IDEAScript macros.

You can also create macros using Visual Script. Visual Script is used to
visually create, edit, and maintain macros in IDEA. In essence, Visual Script
is the visual representation of IDEAScript. The benefit of Visual Script is that
it lets you automate tasks that you perform repeatedly without writing any
code or programming. If required, you can then convert your Visual Script
macros into IDEAScript macros. For more information on Visual Script, see
the IDEA online Help.
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Dashboard Window The Dashboard window lets you view and modify generated or custom built
dashboards. Dashboards are a visual representation of your data, in the form
of field statistics and interactive charts and tables, that can provide valuable
insights.

Dashboards consist of three main sections:

Section Description

Dashboard
title bar

The Dashboard toolbar displays the dashboard name and
contains commands that let you:

l exit the Dashboard window
l save the dashboard
l access online help
l minimize and maximize the window

Field
Statistic
Panels

The field statistic panels are the first row of panels in the
dashboard. You can only add or modify field statistics information
in these panels. Charts cannot be added to these panels. Whether
generated or manually added, each field statistic panel displays
the field statistic value for the selected field within the specified
database.

Chart
Panels

Chart panels appear below the row of field statistic panels.
Chart panels can display treemaps, bar, column, and pie
charts. Within chart panels, depending on the chart, you can
display a chart caption, x and y axis titles, and a legend.You
can also modify charts.





Section 4

Using IDEA
The exercises in this section are meant as an introduction for new users and
a refresher for existing users. Each exercise has an objective to indicate
what you will achieve in that area upon completion. The tutorial exercises
should be completed sequentially as tests are often carried out on the results
of previous exercises.

For more information on using IDEA:

l access the Help system in the software

l visit the CaseWare Analytics Support Portal

l attend one of the many training courses

Accessing IDEA To access the IDEA application from Windows.

1. From the Windows Start screen, click the arrow in the bottom-left
corner.

2. In the Apps view, scroll to the IDEA group and click IDEA.

By default, the Managed project is set to Samples. You can use the
databases in this Managed project to test IDEA features.

Selecting a Project To set a Managed project. One Managed project will be used to
complete all exercises in this section.

1. On the Home tab, in the Projects group, click Select.

2. Under the Managed Projects tab, select Tutorial.

3. Click OK.

The Samples project is closed and Tutorial is now the active project.
The File Explorer is now empty. The Status bar on the bottom left
corner of the application window now displays Managed Project:
Tutorial.

http://www.support.casewareanalytics.com/
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Connecting to IDEA
Server

To connect to IDEA Server. As IDEA Server is a client-server
application, the IDEA databases reside and the tasks run on the
server. Hence, you must connect to the server to access the
databases and analyze the data. See The Association Between
IDEA Working Folders and IDEA Server Projects.

1. On the Home tab, in the IDEA Server group, click Select Server.

The Select Server dialog box appears. A list of available IDEA Server
machines appears. If the list is empty you can add a server.

2. If required, add a server.

a. Click Servers....

The Add/Remove Servers dialog box appears.

b. Click Add.

The Add IDEA Server dialog box appears.

c. In the Name field, enter the name of the IDEA Server machine.

d. Accept or modify the default Authentication Port .

e. ClickOK.

f. In the Add/Remove Servers dialog box, click Close.

3. From the Select a server drop-down list, select the appropriate server.

4. ClickOK.

Importing a
Microsoft Access
File

To import a Microsoft Access file and generate field statistics for the
newly imported database.

1. On the Home tab, in the Import group, click Desktop.

The Import Assistant appears.

2. From the list of available formats, select Microsoft Access.

3. Click the Browse button adjacent to the File name field to select the
Microsoft Access database you want to import.

4. Select Customer.accdb .

5. ClickOpen .

6. In the Import Assistant, click Next.

The Microsoft Access® dialog box appears.

7. From the Select tables list, select Database1.

If you import a Microsoft Access file that contains more than one
table, you may simultaneously import multiple tables by selecting the
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associated check boxes. However, any options you select in the
Character Field Options section are applied to all imported tables.

8. In the Character Field Options section, leave the Scan records for
field length check box selected.

All Character fields are imported with a length of 255 characters
unless IDEA determines the length is shorter.

9. Accept the default value in the Scan only field. Ten thousand records
will be scanned to determine the maximum field length.

10. Accept the default Output file name (Customer).

11. Click OK.

When the file is imported, the database name takes the format
Filename-Tablename. In this case, the file you imported becomes an
IDEA database called Customer-Database1.

Formatting the Data To change the column formatting for selected fields and to sequence
the records.

1. Ensure that Customer-Database1 is the active database with the
Data property selected in the Properties window.

2. Move the cursor to the column separator between the first two field
names. Click the column separator and reduce the width of the CUST_
NO field to fit the data.

3. Hover the cursor over the first field header.

The tooltip displays the field type and the field length.
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4. Sequence the CREDIT_LIM field in ascending order by double-
clicking the column header.

A directional arrow pointing upwards appears in the CREDIT_LIM
column header to indicate the field has been indexed in ascending
order. Also, note how the index is displayed in the Indices area of the
Properties window.

5. In the Indices area of the Properties window, click No index to return
to the original record sequence.

6. In the Database window, right-click the CUST_NO field name to
display a list of commonly used tasks and functions.

7. Select Column Settings... .

The Column Settings dialog box appears.

8. For the CUST_NO field, set the Text color to blue, the Background
color to light gray, and change the Font to bold.
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9. For the CREDIT_LIM field, set the Text color to purple and the
Background color to light gray. Select the Use currency symbol and
Use thousands separator check boxes.

10. Click OK to exit the Column Settings dialog box.

Note that the formatting changes have been applied to the database.

11. Re-order the fields by moving the CREDIT_LIM field after the CUST_
NO field. Click the CREDIT_LIM column header to select it, and then
click it again and hold down the mouse button to display the drag icon.
Drag the column towards the CUST_NO field. Note the red line
indicating the drag position. Drop the column to the right of the CUST_
NO field.

When you modify a view, IDEA saves the settings with the
database. These settings remain active until you modify or reset
them. Any child databases created from this database, inherit
the settings.

12. On the View tab, in the Views group, click Reset to remove the format
changes.

Viewing the Field
Statistics

To view the field statistics for the Numeric fields in the active
database.

1. Ensure that Customer-Database1 is the active database and the
Data property is selected in the Properties window.

2. In the Properties window, click Field Statistics.

3. Click Yes to generate field statistics for all fields.
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By default, the Field Statistics window displays the statistics for
Numeric fields. In this case, field statistics appear for the CREDIT_
LIM field, the only Numeric field in the database.

4. Study the field statistics for the CREDIT_LIM field.

5. In theMaximum Value field, click the value to view the record with the
maximum value.

6. The Maximum Value of CREDIT_LIM dialog box appears, displaying
the record from the database that constitutes the maximum value.

You may save or print the record.

7. Click Done .

8. In the Database area of the Properties window, click Data to return
to viewing the database.

Selecting a Random
Record Sample

To select a random sample of records for testing.

1. On the Analysis tab, in the Sample group, click Random.

2. In the Number of records to select field, enter 10.

3. Accept the Random number seed value provided by IDEA.

IDEA uses the random number seed to start the algorithm for
calculating the random numbers. If a sample needs to be extended,
then entering the same random number seed but with a larger sample
size produces the same original selection plus the required additional
records.

4. Accept the default values in the Starting record number to select
and the Ending record number to select fields.

IDEA sets the defaults as the first and last records; in this case 1 and
341.

5. Leave the Allow duplicate records check box unselected.
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6. In the File name field, enter Sample of Customers.

7. Click Fields.

The Fields dialog box appears. Note that by default, IDEA selects all
fields from the database to extract to the Sample of Customers
database.

8. ClickOK.

9. In the Random Record Sampling dialog box, click OK.

10. View the output database and note the additional field (SAM_RECNO)
that IDEA has added to the database as the right-most column. This
contains the corresponding record numbers from the original database
(Customer-Database1). Note that the database appears as a child
database to its parent database (Customer-Database1) in the File
Explorer window.

11. To close the Sample of Customers database, right-click the Sample
of Customers tab and select Close.

Extracting Records To extract records of customers with high credit limits.

1. On the Analysis tab, in the Extract group, click Direct.

2. In the first row of the File Name column, replace the default file name
with Large Credit Limits.
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3. Enter the equation CREDIT_LIM >= 30000.

4. Click OK to start the extraction.

The output database, Large Credit Limits, appears in the Database
window. It contains 61 records.

5. Right-click the Large Credit Limits tab at the top of the Database
window, and select Close.

6. Close the Customer-Database1 database.

Importing a Text File To import the sales file that has been provided in Fixed Length text
format.

1. On the Home tab, in the Import group, click Desktop.

The Import Assistant appears.

2. From the list of available formats, select Text.

3. Click the Browse button adjacent to the File name field.
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The Select File dialog box appears. It defaults to the Source Files
Library group in the active project.

4. Select sales.txt .

5. ClickOpen .

6. In the Import Assistant, click Next.

Once you have selected the data file, the Import Assistant analyzes
the data file and tries to determine its type. IDEA correctly identifies
the format as Fixed Length.

7. Click Next.

In the Specify Record Length screen, IDEA correctly identifies the
length of each record, which is 42 bytes (characters), including the
record delimiters. IDEA automatically excludes the record delimiters
from the import.

8. Inspect the file in the preview. Scroll through the records and check
that the columns of data (fields) line up. Click Next.

In the Specify Field Delineators screen, you can identify the start and
end positions of each field within the records. The Import Assistant
inserts lines for a best fit based on the pattern of data within the
records.It is usual to obtain a record definition for Fixed Length files.

9. Modify the line positions of the field delineators according to the
following record definition. Note that Type is C (Character), D (Date),
or N (Numeric):

Name Type Start Len Other Desc

INV_NO C 1 7 Invoice Number

TRANS_
DATE

D 8 8 YYYYMMDD

(mask)

Transaction
Date

PAY_TYPE C 16 4 Payment
Method

SALES_ID C 20 3 Salesperson ID

CUST_NO C 23 5 Customer
Number

PROD_
CODE

C 28 2 Product Code

AMOUNT N 30 11 2 decimal
places

Transaction
Amount
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10. Click Next .

11. In the Field Details screen, you must enter the details for each field,
including identifying which fields or areas you do not want to import.
Use the information in the record definition that was provided in the
previous step to complete the details for each field.

12. Once you have defined all the fields, click Next .
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13. In the Create Field screen, you can add Virtual, Editable, Boolean, or
Multistate fields to the file you are importing. For the purposes of this
exercise, do not create any fields. Click Next .

14. In the Import Criteria screen, you can enter an equation to filter the
data that is to be imported into IDEA. For the purpose of this exercise,
do not enter an equation. All records in the sales.txt file are required for
subsequent exercises in this tutorial. Click Next.

15. In the Specify IDEA File Name screen, which is the final step in the
import process, you must specify the import options and name the
resulting database.

a. Accept the option to import the file (rather than link to the file).
IDEA runs faster when you import rather than link to a file.

b. Select the Generate field statistics check box. The field statistics
can be used for reconciliation.

c. Accept the default value in the Save record definition as field.
IDEA automatically saves the record definition as sales.rdf/.rdm in
the Library. You can use this record definition later to import similar
data files or modify the existing record definition.

d. In the Database name field, enter Sales Transactions.

15. Click Finish.

IDEA imports the file into the project, and then opens and displays it in
the Database window.

16. In the Properties window, click Control Total.

17. Select the AMOUNT field, and then click OK.
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The control total of 6,406,119.08 appears next to the Control Total link
in the Properties window. Auditors should reconcile this amount to the
total sales from an outside source for the period before commencing
audit testing.

Discovering Insights
from Data

To use the Discover task in the Visualization feature to gain insights
into data.

1. Ensure Sales Transactions is the active database and the Data
property is selected in the Properties window.

2. On the Analysis tab, in the Visualization group, click Discover .

When the Discover analysis is complete, the generated dashboard
displays selected field statistics as well as graphs and charts of the
data. These statistics and charts can be changed if you wish.

3. From the dashboard title bar, click Save.

The Save dialog box appears.

4. In the File name field, enter Sales Transactionsand click Save.

The field statistic panels at the top of the dashboard display the most
relevant field statistics for the Sales Transactions database.

Review the four charts in the bottom of the Dashboard. There are two
column charts, a treemap and a pie chart showing information about
the Sales Transactions database.

l In the first column chart, you can see that the data is the
count of records for AMOUNT stratified into $500.00 bands.
The final column, shown in red, represents outlier data
points. So the majority of the transactions are for amounts
between 0 and 500 dollars.
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l The second column chart shows the number of records
stratified by the month of the transaction date. The busiest
month is July. The quietest month is January.

l The Treemap represents two different things. The size of
each node represents a count of the number of transactions
for a given product code. The color indicates the relative
value of the underlying transactions. Blue is a low value,
purple is moderate and red is high. This treemap shows that
product code 05 makes up the vast majority of all
transactions (834/900) and represents a moderate amount
of revenue (2,272,186.70). Product code 06 has only three
transactions, but represents 3,790,308.66 in sales.

l The Pie chart indicates the percentage of the average sales
amount for each Salesrep. Almost 55% are associated with
sales rep 118.

You are now going to modify the information in the dashboard.

Clearing Information in a Field Statistic Panel

1. Place your cursor in the first field statistic panel on the left.

The Properties button appears in the panel toolbar at the top right
of the panel.

2. Click the Properties button.

The Field Statistic Properties dialog box appears.

3. Click Clear and then click Save .

Editing Information in a Chart Panel

1. Place your cursor in the Pie chart panel to display the panel toolbar in
the upper right corner.

2. Click the Properties button.

The Chart Properties dialog box appears. From this dialog box you can
change the chart type as well as modify the properties.

3. From theGroup by drop-down list, select PAY_TYPE.

4. From the Statistic drop-down list, select Count.

Note that as you modify the properties, the chart automatically
updates. Also note that the chart caption also automatically updates.
You can modify the chart caption to a custom title.

5. In the Chart caption field, enter Count of Transactions by Payment
Method.

6. Accept the default selection of the Show Legend check box.
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7. Click Save.

The modified panel is added to the dashboard.

8. Save and close the dashboard.

Using a Treemap to
Visualize your Data

To use the Visualize task in the Visualization feature to create a
treemap.

1. On the Analysis tab, in the Visualization group, click Visualize.

The Select a Dashboard window appears.

2. Click New Dashboard.

The Chart Properties dialog box appears.

3. In the Properties pane on the right, click the Treemap button.
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Since the Sales Transactions database was the active database, it
appears automatically in the Database field.

4. From theGroup by drop-down list, select CUST_NO .

5. From the Color by drop-down list, select Sum.

6. From the Field to Sum drop-down list, select AMOUNT.

7. Accept the default selection of Count for the Size by field.

8. In the Chart caption field, enter Customer Purchases.

9. Click Save.

The Select a Layout page appears.

10. Do one of the following to display the chart panel layout you want to use
in your dashboard:
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l Click the Next and Previous buttons to scroll through the
available layouts.

l Click the appropriate layout option button.

11. Display the option with a single panel and click Select or double-click
the layout image.

The Dashboard window appears. The newly created chart is displayed
in the chart panel.

12. From the Dashboard title bar, click the Save button to save this new
dashboard as Customer Purchases.

The Treemap display a series of nodes, each of which represents a
customer. The larger the node, the more transactions that customer
has made. The sum of a customer’s transactions influences the color;
therefore, the one red square indicates both a relatively large number
of transactions as well as a significantly higher sum of transaction
amounts compared to the other customers.

13. Hover your cursor over the red node to display the node information.

The node information includes the field from which categories are
created, the category name, and the size and color values.

14. Click the red square to display the underlying records.
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15. Close the dashboard window.

Opening a Previously Saved Dashboard

1. On the Analysis tab, in the Visualization group, click Visualize.

The Select a Dashboard window appears. A list of saved dashboard
appears. You can edit the name and description for a dashboard from
this window.

2. Hover you cursor over the Customer Purchases dashboard in the list
and click the associated Edit button.

The Name and Description fields are now editable.

3. In the Name field, enter 2014 Customer Purchases .

4. In the Description field, enter Customer purchases for 2014.

5. Click the associated Save button.

You can click the associated Discard button to return to the previous
name and description.
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6. From the list of available dashboard, double-click the dashboard you
want to open.

Summarizing the
Data

To total the sales transactions by customer to produce a list of
outstanding balances as well as to identify the number of active
accounts and the number of transactions per account.

1. On the Analysis tab, in the Categorize group, click Summarization.

The Summarization dialog box appears.

2. Select the CUST_NO field as the field to summarize and the
AMOUNT field as the field to total.

3. Click Fields.

The Fields dialog box appears. Note that no fields are selected. This
stops unnecessary information from being included in the summarized
database.

4. ClickOK to return to the Summarization dialog box.

5. Select the Use Quick Summarization check box.

The Use Quick Summarization check box may be selected as a faster
means to summarize your database. However, Quick Summarization
may only be used if the database has no more than 4,000 unique keys.
In addition, Quick Summarization lets you select only one field to
summarize.

Note that when Quick Summarization is used, Sum in the Statistics to
include section is selected by default and the entire section grayed
out.

6. Accept the Create database check box selection.

The output database for this task will be joined to Customer-
Database1 in a later exercise. Note that as with most tasks in IDEA,
you may apply a criterion to the task, for example, to only summarize
transactions for a specified period. As with all other tasks where you
can apply a criterion, if you apply the criterion to the database using
the Criteria link in the Properties window, the criterion equation
appears in the Criteria text box on the task dialog box. However, you
may enter a new criterion or modify an existing one using the Equation
Editor.
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7. In the File name field, enter Summarized Transactions.

8. ClickOK.

9. View the output database. Also note the number of records (303) on
the Status bar.

Stratifying the Data To stratify outstanding balances to gain a profile of the number and
value of accounts within bands.

1. Ensure that Summarized Transactions is the active database and the
Data property is selected in the Properties window.

2. In the Properties window, click Field Statistics.
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3. Click Yes to generate the statistics.

4. View the numeric statistics for the AMOUNT_SUM field.

5. In the Properties window, click Data .

6. Right-click any record in the Database window, and then select Show
Field Stats....

7. From the list of available statistics for Numeric fields, select the Net
value, Absolute value, Minimum value, andMaximum value
statistics.

8. Click OK.

The selected statistics appear in a yellow band at the top of the
Database window.

9. Adjust the column widths, including the record number/statistic name
column to view the full statistic names and totals. Move the cursor
over the rows and note the tooltips displaying the statistic names.

10. Right-click any record in the database, and select Show Field Stats...,
and then click Clear All.

11. ClickOK to remove the Show Field Stats yellow band from the
database.

12. On the Analysis tab, in the Categorize group, click Stratification.

The Stratification dialog box appears.

13. From the Field to stratify list, select AMOUNT_SUM .

14. From the Fields to total on list, select NO_OF_RECS.

15. Change the Increment to 5,000.00.

16. Click in the < Upper Limit text box of the first row.

17. Click the second row of the spreadsheet area.

18. Highlight the next three rows of the spreadsheet area to take the range
to 25,000.00.

19. Change the Increment to 25,000.00 .

20. Highlight the next seven rows of the spreadsheet area (to row 12).

21. Ensure the Create result check box is selected.
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22. In the Result name field, enter Numeric Stratification.

23. Click OK.

The Results output for the Summarized Transactions database
becomes active and appears as a link in the Results area of the
Properties window.

Note that there are 219 accounts in the first band (greater than or
equal to 0 and less than 5,000.00).

24. On the File tab, in the Print group, click Print Preview.
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25. Adjust the magnification to view the report (for example, 100%).

26. Close the Print Preview window to return to the Results output.

Viewing the Results
Graph

To create a custom graph depicting the results of the Stratification
task.

1. Ensure that Summarized Transactions is the active database and
Numeric Stratification is selected in the Results area of the
Properties window.

2. From the Results toolbar, click the Alternates between displaying
the results in a customizable graph and grid button to graph the
results.

3. From the Chart toolbar, click the Gallery button and select each chart
type in turn to view the options available.

As you select the different chart types, notice that the icon for the
Gallery button on the chart toolbar changes to depict the type of chart
selected.

4. Re-select the bar graph option.

5. From the Chart toolbar, click the Properties button.

6. Click the Y Axis tab.

7. Ensure the Show Gridlines check box is selected, and then clickOK.

8. Place your cursor over stratum 6 in the graph and note that its color is
solid and its X- and Y-axes values (stratum number and total amount)
appear in a tooltip.
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9. Click the stratum 6 bar, and then select Display Records to view the
accounts making up the summary amount.

10. Click Done .

11. From the Results toolbar, click the Alternates between displaying
the results in a customizable graph and grid button to return to the
viewing the stratification Results output grid.

12. In the Properties window, click Data to return to the Summarized
Transactions database.

13. Close all open databases.

Creating a Pivot
Table

To profile the Sales Transactions database in a table format and to
createmultiple summarizations in a table by calculating the sum,
the average, or the count of items.

1. Open the Sales Transactions database.

2. On the Analysis tab, in the Categorize group, click Pivot Table.

The Pivot Table dialog box appears.

3. In the Result name field, enter Sales Transactions Pivot Table, and
then clickOK.

4. In the Pivot Table Field List dialog box, click PAY_TYPE and drag it
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onto the row header field displaying Drop Row Fields Here. Click
PROD_CODE and drag it onto the column header field displaying
Drop Column Fields Here. Click AMOUNT and drag it onto the Drop
Data Items Here area. Click Close.

If the data is too wide for the field, IDEA displays the values as pound
signs (#). Click and drag the column separators to widen the fields in
order to view the actual values.

You have just profiled the Sales Transactions database by payment
type and product code with the sum of the amount for each
combination of them.

5. Right-click one of the product code column headers to access a right-
click menu. This menu provides options to hide the totals or to reverse
the order of the product code display. Select and deselect the menu
options and make note of the changes.

6. Right-click any record in the table to display the Pivot Table Field dialog
box.

7. In the Summarize by list, click Count and then click OK.

8. To view the records for the four sales of Product Code 02 that were
paid using American Express (AMEX), select the footer total for
Product Code 02 and then click the View the records that make up a
selected value in the Data Area button on the Pivot Table toolbar.

9. Click Done .

10. The IDEA Pivot Table lets you have multiple fields in the row, the
column, or in the data area. From the Pivot Table toolbar, click the
Opens the Pivot Table Field List dialog box button to access the
Pivot Table Field List dialog box. Add the SALES_ID field to the
column area, placing it to the left of the PROD_CODE field. Click
Close.

11. Now, display only the sales of product codes 02 and 04 , but have the
sales ID as the primary focus. Click the drop-down arrow in the PROD_
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CODE field header and select only the check boxes for product codes
02 and 04 .

12. Note that you can collapse or expand the detail of each salesman by
clicking the plus or minus symbols next to the salesman number. To
collapse all, right-click the SALES_ID field in the column area and then
select Collapse all.

13. In the Properties window, click Data .

14. Close the Sales Transactions database.

Joining Databases To join two databases together.

1. Open the Summarized Transactions database.

The common key by which the databases are to be joined is the
customer number field in each database. The data type of this key
field must be the same, but the field lengths may vary.

2. On the Analysis tab, in the Relate group, click Join.

The Join Databases dialog box appears with Summarized
Transactions listed as the primary database.

3. Click Fields for the primary database.

The Fields dialog box appears. Note that all fields are selected for the
output database.

4. ClickOK to close the Fields dialog box.

5. Click Select to select the secondary database.

6. Select the Customer-Database1 database, and then click OK.

7. In the File name box, enter Customer Balances .

8. ClickMatch to specify the common match key.

9. Click the first row in the Primary column and select CUST_NO from
the list of fields.

Note the Order column and accept the default, Ascending.

10. Click the first row in the Secondary column, and then select CUST_
NO from the list of fields.

11. ClickOK.
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12. Select the All records in both files option.

13. ClickOK to join the selected databases.

14. View the output database, Customer Balances. It contains 351
records.

Reviewing the
History

To view the History maintained by IDEA to check what has been
done.

1. Ensure that Customer Balances is the active database and the Data
property is selected in the Properties window.

2. In the Properties window, click History.

3. Expand out and examine each section of the History log.

4. Locate the last section, which contains the details of how the
databases were joined.

Note the following:

l Number of records: 351 (matched sales to customers)

l Unmatched primary records: 10 (sales to customers not in the
Customer-Database1 database)

l Unmatched secondary records: 48 (customers with no sales in the
period)

5. Examine the IDEAScript code section of the Join Databases
history.

This can be used to re-perform or automate the audit tests.

6. Collapse the History for the Join Databases task.
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Using Display All
Records Containing

To find all unmatched records or all occurrences of a particular
instance of data.

1. Ensure that Customer Balances is the active database and the Data
property is selected in the Properties window.

2. Locate record 9 . Note that there is no value in the CUST_NO1 field for
this record (a sale for which there is no match in the Customer-
Database1 database).

3. Right-click the blank record 9 for the CUST_NO1 field, and then
select Display all records containing “”.

The Display All Records Containing… dialog box appears.

4. Click OK.

IDEA applies the criterion CUST_NO1 == “” to the database and
displays it beside the Criteria link in the Properties window.
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Note that there are 10 records that meet the specified criterion. This is
the number of transactions for which there are no records in the
Customer-Database1 database.

5. Right-click the Criteria link in the Properties window, and then select
Clear.

The criterion is removed from the database and all records are
displayed.

6. Repeat the process to identify all customers with no sales in the
period using the criterion AMOUNT_SUM==0.00.

There are 49 records. These are the accounts with no outstanding
balances.

7. Clear the criterion to return to viewing all records in the Customer
Balances database.

Appending a Virtual
Field

To append a Virtual (calculated) field to calculate a new credit limit
and to identify the accounts where the new credit limit has been
exceeded.

1. Ensure that Customer Balances is the active database and the Data
property is selected in the Properties window.

2. On the Data tab, in the Fields group, click Append.

3. Enter the following details:

l Field name: NEW_LIMIT

l Field type: Virtual Numeric

l Length: Not applicable for Numeric fields

l Number of decimals: 2

l Parameter: CREDIT_LIM * 1.1
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l Description: Updated Credit Limit

4. ClickOK to append the NEW_LIMIT field.

5. Scroll completely to the right in the database and note that the NEW_
LIMIT field has been added as the last field in the database.

The color of data in Virtual fields is determined by the color set in the
Database Grid tab of the IDEA Options dialog box. The IDEA Options
dialog box is accessible from the File tab.

Performing a Record
Extraction

To perform an extraction to identify accounts where the new credit
limit has been exceeded.

1. Ensure that Customer Balances is the active database and the Data
property is selected in the Properties window.

2. On the Analysis tab, in the Extract group, click Direct.

3. In the File Name column, replace the default file name with Exceeded
Credit Limits .

4. Click the Equation Editor button , and then enter the equation
AMOUNT_SUM > NEW_LIMIT.
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5. From the Equation Editor toolbar, click the Validate and Exit button to
return to the Direct Extraction dialog box.

6. ClickOK.

7. View the output database of 11 records (including sales to
unauthorized customers).

8. Close all open databases.

Identifying Duplicate
Invoices

To test the validity of invoices and to test for duplicate invoice
numbers.

1. Open the Sales Transactions database.

2. On the Analysis tab, click Duplicate Key and then click Detection.

The Duplicate Key Detection dialog box appears.

3. Accept the default selection of the Output Duplicate Records option.

4. In the File name field, enter Duplicate Invoices.

5. Click Key.

The Define Key dialog box appears.
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6. In the Field column, select INV_NO and leave the direction as
Ascending.

7. Click OK to return to the Duplicate Key Detection dialog box.

8. ClickOK to run the task.

9. View the output database of four transactions with two pairs of
duplicate invoice numbers (1000097 and 1000350), which should be
investigated.

10. Close all open databases.

Identifying Similar
Records

To identify similar records in Character fields.

1. Open the Customer-Database1 database.

2. On the Analysis tab, in the Explore group, click Duplicate Key and
then click Fuzzy.

The Fuzzy Duplicate dialog box appears.

3. Accept all default values in the Output and Settings sections.

4. Click Key.

The Define Fuzzy Match Key dialog box appears.

5. From the Character fields list, select LAST_NAME and click
ADD>>.
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6. ClickOK. You are returned to the Fuzzy Duplicate dialog box.

7. In the File name field, enter Fuzzy Duplicates - Customer.

8. ClickOK.

9. View the resultant database of 47 records. Four new fields are added to
the output database:

Field Description

GROUP_ID The group identification number assigned to a fuzzy
group. TheGROUP_ID is assigned to all records within
the fuzzy group.

GROUP_
NAME

The name of the fuzzy group. The fuzzy group name is
taken from the record that has the largest amount of
fuzzy matches. This record is known as the group core.
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Field Description

SIMILARITY_
DEGREE

The degree of similarity computed between the record in
the fuzzy match field and the associated group core.
The value ranges between 0 and 1, where 0 indicates no
relationship and 1 indicates an exact duplicate.

RECORD_
NUM

The row number of the record in the parent database.

Rerun the task to remove the exact duplicates and adjust the similarity
degree.

10. On the Analysis tab, in the Tasks group, click Re-run .

11. In the Settings section, clear the Include exact duplicates check box.

12. In the File name field, enter Fuzzy Duplicate - Customer No
Duplicates.

13. ClickOK.

14. View the output database of eight records and observe the values in the
SIMILARITY_DEGREE field. Records with a value of 1.0000 are the
group core names and subsequent fuzzy matches to this value are
compared to this record. Entries with a match value of less than 80%
are not reflected in this output.

15. Re-run the task again and reduce the value of the Similarity degree
(%) slider bar to 70%.

The output database should have 35 records.

16. Close all open databases.
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Identifying Gaps in
an Invoice Number
Sequence

To test for completeness and to test for gaps in the invoice number
sequence.

1. Open the Sales Transactions database.

2. On the Analysis tab, in the Explore group, click Gap Detection.

The Gap Detection dialog box appears.

3. From the Field to use drop-down list, select INV_NO .

4. In the Character section, accept the default mask (NNNNNNN).

5. In theOutput section, ensure the Create result check box is selected.

6. In the Result name field, enter Missing Invoice Numbers.

7. Click OK.

The Results output Missing Invoice Numbers becomes active.
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Performing a Key
Value Extraction

To manually select records based on key values and extract them to
a separate database.

1. Ensure that Sales Transactions is the active database and the Data
property is selected in the Properties window.

2. On the Analysis tab, in the Extract group, click Key Value.

The Key Value Extraction dialog box appears.

3. Click the Browse button adjacent to the Existing keys drop-down list.

The Define Key dialog box appears.

4. Create the key PAY_TYPE/A + PROD_CODE/A and then click OK.

All of the different PAY_TYPE/A + PROD_CODE/A values are now
listed and selected in the lower part of the Key Value Extraction dialog
box.
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5. In the Groups Found section, click Clear All and then select only the
VISA payments for product codes 05 and 06.

6. Optionally, you can enter criteria. Since the objective is to extract all of
the sales transactions that were paid using VISA for product codes 05
and 06, leave the Criteria field empty.

7. Accept the default selection of the Create a separate database for
each unique key check box. Note that you could have decided to put
all the resulting records in one database.

8. Click OK.
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In the File Explorer window, IDEA has created two new child
databases under the Sales Transactions parent database:
KeyVal=VISA + 05 and KeyVal=VISA + 06.

9. Close all open databases.

10. In the File Explorer window, right-click the two new child databases and
select Rename . Name the databases Visa Payments for Product
Code 05 and Visa Payments for Product Code 06.

Performing a Record
Extraction Using an
@Function

To carry out a more advanced exception test in order to identify all
transactions processed on a Sunday.

1. Open the Sales Transactions database.

2. On the Analysis tab, in the Extract group, click Direct.

3. In the File Name column, replace the default file name with Sunday
Transactions.
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4. Create the following equation:

@Dow(TRANS_DATE) = 1

5. ClickOK to perform the extraction.

6. View the output database and its History. There should be 90 Sunday
transactions.

7. Close the Sunday Transactions database.

Designing a Report To select and format the data to be displayed and printed.

1. Ensure that Sales Transactions is the active database and the Data
property is selected in the Properties window.

2. On the File tab, click Print and then click Create Report to create a
report using the view settings.

The Report Assistant appears.
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3. Select the Create new report option and the Allow headings to
span multiple lines check box. Click Next.

4. In the Headings screen, select each field (one at a time) and enter a
short but descriptive name in the Text field. This text is used for field
names. Accept the default alignment selections. Click Next.



CA401 IDEA Tutorial

60

5. In the Define Breaks screen, define a report break on the CUST_
NO/A + TRANS_DATE/D key. Click Next.

IDEA displays the records in the report in the order of the index.
IDEA displays the index description in the Indices area of the
Properties window once you have completed the report.

6. In the Report Breaks screen, create a break and total the AMOUNT
field for each customer number (CUST_NO). Select the following
options: Count records in break, Show break line, Show leading
break. Set the break spacing to 3 lines. Total the AMOUNT field.
Select the Show shading and Use currency symbol options. Click
Next.
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7. In the Grand Totals screen, create grand totals for the AMOUNT field,
set the font style to bold, and then click Next.

8. In the Header/Footer screen, enter/select the following information,
and then click Finish.

l Print cover page: Select this check box.

l Title: Sales Transactions

l Comments: Sequenced by customer number and date.

l Prepared by: Enter your name or initials.

l Header: Enter the name of your organization.

l Footer: Enter the name of your department.

l Date/Time: Accept the defaults unless you have particular
preferences.
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The options you have selected affect how the report is printed.
The name entered into the Prepared by field appears on reports
accessed via the Print Preview of a Results output.

9. Click Yes to preview the report.

10. From the Print Preview toolbar, click 1-2 Pages to toggle between a
single page and two pages.

11. From the Print Preview toolbar, click Zoom In to view the report in
detail. (There are two levels of zoom.)

12. Check that all settings, including field widths, are correct.

If you wish to print the view, click the Print button on the Print
Preview window. All of the settings selected for the report (break
totals, field headings, totals, and cover page information) are
saved with the view. Every time you create a report, you must
save the view in order to save the report settings.

13. From the Print Preview toolbar, click Close to close the Print Preview
window.

Creating an Action
Field

To produce an action when you click on a value in a specified field.

1. Open the Customer-Database1 database.

2. Right-click any record in the CUST_NO field and select Define
Action Field... .

The Define Action Field dialog box appears.

3. Ensure that the Create Action Link to display extraction preview
option is selected.

4. Click the Browse button and select the Summarized Transactions
database. ClickOK to close the Select Database window.

5. Click Look-up Fields.

The Fields Not Found dialog box appears.

6. Click OK.

The Look-up Fields dialog box appears.

7. Ensure that the CUST_NO field is selected, and then click OK to
return to the Define Action Field dialog box.
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8. Click OK in the Define Action Field dialog box to create the Action
Field link.

The Customer-Database1 database now has a link (in blue and
underlined) to the Summarized Transactions database.

9. In the CUST_NO field, click the first record to display the Extraction
Preview window. The transactions total for customer number 10000 is
displayed.

10. Click Done .





Appendix I

Housekeeping
As with all computer systems, housekeeping (including backing up data and
deleting unwanted files) is extremely important when working with IDEA.

For file management maintenance, such as deleting, copying, or moving
databases and files, it is recommended to use the File Explorer or Library
features. Using Windows Explorer to manage files is not recommended.

Backing Up and
Restoring Data Files

Youmay want to back up files for a variety of reasons, such as, to transfer
files to another computer; to back up according to risk/criticality of data or
because of disk space restrictions.

IDEA uses a single compound file with the file name extension *.imd
(Unicode versions of IDEA use the file name extension *.idm) to store all the
information associated with a file, such as the data, the schema, History,
comments, indices, and reports.

IDEA stores each of these files in its project. However, the view files,
equation files, definition files, and any text files created are not stored within
the compound file.

The following list outlines the file type, the location and file name extensions
(ASCII and Unicode).In order to backup IDEA Server project files, please
contact your IDEA Server Administrator:

File Type Location ASCII File
Extension

Unicode File
Extension

Data and Related
Files

Managed or External
project

.imd .idm

Views Library .vw2 .vwm

Equations Library .eqx .eqm

Custom Functions Library .ideafunc .ideafunc

Record Definitions Library .rdf .rdm

Report Reader
Templates

Library .jpm .jpm

Project Information Managed or External
project

.inf .inf
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File Type Location ASCII File
Extension

Unicode File
Extension

IDEAScript Macros Library .iss .ism

Compiled
IDEAScript

Library .exe .exe

Visual Script
Macros

Library .vscript .vscript

External Variable
Files

Managed or External
project

.evars .evars

Dashboard Files Library .idash .idash

UseWindows Explorer or any other backup facility to back up the required
file.

Deleting Databases Deleting databases that are no longer used lets you maximize disk space
and clean up your project. If you attempt to delete a parent database, you
can choose to delete the associated child database or break the parent-child
relationship and only delete the parent. When you break the parent-child
relationship, the orphaned child databases become top-level databases.

Note that databases must be closed before you attempt to delete them.

To delete the active database:

1. On the File tab, in the Database group, click Delete Database.

2. Click Yes to confirm the delete request.

To delete all or selected databases:

1. Ensure all databases are closed.

2. From the File Explorer toolbar, click the File Display button and then
click Expand All to expand out all nodes in the File Explorer window.

3. Select the databases you want to delete.

4. From the File Explorer toolbar, click the Delete button.

5. Click Yes to confirm the delete request.

Deleting Other Files Use the Library to delete other files, such as record definitions, views, and
equations.

To delete associated project files:

1. Click the Library tab.

The Library window appears.

2. Expand the appropriate Library group node.

3. Right-click on a file and select Delete.

4. Click Yes to confirm the delete request.
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Copying Data Files Use the Copy To command in the File Explorer window to copy IDEA
databases to other projects. The Copy To command in the Library window
lets you copy files to other Library groups or projects.

To copy one or more selected databases to another project folder:

1. In the File Explorer window, right-click on the database you want to
copy.

2. Select Copy To....

3. Navigate to and select the required folder.

4. ClickOK.

To copy one or more selected files to another Library:

1. In the Library window, expand the required Library group, and right-click
on the file you want to copy.

2. Select Copy To and then select Local Library or Corporate Library
(if available).

The file is copied to the same Library group in selected Library.

To copy one or more selected files to another project:

1. In the Library window, expand the required Library group, and right-click
on the file you want to copy.

2. Select Copy To and then select Another Project….

The Copy File dialog box appears.

3. To copy to an External project, do the following:

a. Select the External project option.

b. Click the Browse button adjacent to the External project field.

c. Navigate to and select the appropriate folder.

d. ClickOK to return to the Copy File dialog box.

4. To copy to a Managed project, do the following:

a. Select the Managed project option.

b. Click the Browse button adjacent to the Project field.

c. Navigate to and select the appropriate project.

d. ClickOK to return to the Copy File dialog box.

e. From the Group drop-down list, select the group into which you want
the file copied.

5. ClickOK.
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Moving Data Files Use the Move To command in the File Explorer window to move IDEA
databases to other projects or locations.

To move one or more selected databases to another project folder:

1. In the File Explorer window, right-click over the name of the database
you want to move.

2. Select Move To....

3. Navigate to and select the required folder.

4. ClickOK.

Refreshing the File
Explorer

You can update the IDEA File Explorer one of two ways:

l Press F5.

l From the File Explorer toolbar, click the Refresh List button.



Appendix II

@Functions
IDEA provides @Functions for performing operations such as date
arithmetic, financial and statistical calculations as well as text searches.

The@Functions are accessed through the Equation Editor. Quick help
including the syntax, description, and an example of use for each of the
@Functions is available when the @Function is highlighted. Additional and
detailed help is provided in the Equation Editor Help system accessed
through the Help button on the Equation Editor toolbar.

You can also create custom functions. For more information, see the
IDEA online Help.

Take a look at the definitions below to become familiar with each @Function:

@Function Description

@Abs Returns the absolute value of a numeric expression.

@Afternoon Returns 0 if time is in the AM and 1 if time falls in the
PM and -1 for an invalid time.

@Age Calculates the number of days between two dates.

@AgeDateTime Returns the number of seconds between two dates
and times.

@AgeTime Returns the number of seconds between two times.

@AllTrim Removes all leading and trailing spaces.

@Ascii Provides the ASCII value of a character. (Not
available in Unicode versions of IDEA.)

@Between Determines if a numeric expression falls within a
specific range.

@BetweenDate Returns a number indicating whether a date value
falls within a specified range (1) or not (0).
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@Function Description

@BetweenTime Returns a number indicating whether a time value
falls within a specified range (1) or not (0).

@Bit Identifies a bit value.

@BitAnd Masks out unwanted bits.

@BitOr Sets required bit.

@Chr Provides the character equivalent of a specified
ASCII code. (Not available in Unicode versions of
IDEA.)

@CompareNoCase Ignores uppercase letters when comparing
expressions.

@CompIf Determines if a record satisfies multiple criteria.

@Ctod Converts character dates to IDEA Date format.

@Ctot Converts a Character field containing time values
stored as a string to a Time field with a Time format
(HH:MM:SS).

@CurForm Converts numeric value into a formatted text.

@CurVal Converts formatted Character fields to Numeric
fields.

@Date Returns the present date.

@Day Returns the day in a date expression.

@DaysToD Converts a number of days since Jan. 1, 1900 to date
format.

@Db Calculates the fixed declining-balance depreciation
for a specified period.

@Ddb Calculates double declining-balance depreciation.

@Delete Deletes a specified number of characters from a
string.

@Dow Returns the day of the week.

@Dtoc Converts date expressions to character.

@DToDays Reveals the number of days between Jan. 1, 1900
and a specified date.

@Dtoj Converts dates to Julian format.
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@Function Description

@Exp Calculates the exponent of a numeric expression.

@FieldStatistics Returns the numeric value for a specified field
statistic.

@FindOneOf Finds the position of the first matching character in 2
strings.

@FinYear Returns the financial year for a given date based on
the year end.

@Format12HourClock Returns a string representing time formatted as
HH:MM:SS TT.

@Fv Calculates the future value of an investment.

@GetAt Returns the character that appears in a specified
numeric position.

@GetNextValue Returns the next value in the selected field.

@GetPreviousValue Returns the previous value in the selected field.

@Hours Returns the hours portion of a given time.

@If Allows a choice of two results based on the
evaluation of a condition.

@Insert Inserts a string into an existing string.

@Int Returns the integer portion of a numeric value.

@Ipmt Calculates the interest payment for a given period.

@Irr Calculates internal rate of return.

@IsBlank Tests if a Character field is blank.

@IsFieldDataValid Returns a 1 if the data in the field is valid, or a 0 if the
data is invalid.

@Isin Returns the starting position of a string within another
string (case sensitive).

@Isini Returns the starting position of a string within another
string (NOT case sensitive).

@Jtod Converts Julian dates to IDEA Date format.

@JustLetters Returns a string with all the numeric characters
removed.

@JustNumbers Returns all the numbers (leading and trailing).
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@Function Description

@JustNumbersLeading Returns the leading numbers.

@JustNumbersTrailing Returns the trailing numbers.

@LastDayofMonth Returns the last day for any givenmonth and year
combination.

@Left Returns the specified left-most characters in a string.

@Len Returns the length of a string, including any trailing
spaces.

@List Determines which criteria in a list of values is met by
an expression.

@Log Calculates natural logarithms.

@Log10 Calculates logarithm 10x.

@Lower Converts all characters in a string to lowercase.

@Ltrim Removes leading spaces from a string.

@Match Determines which criteria in a list of values is met by
an expression.

@Max Returns the greater value of two numeric
expressions.

@Mid Extracts a portion of text from within a string.

@Min Returns the smallest value of two numeric
expressions.

@Minutes Returns theminutes portion of a given time.

@Mirr Calculates modified internal rate of return.

@Month Returns themonth in a date expression.

@NoMatch Determines if an expressionmeets none of the
criteria in a list of values.

@Npv Calculates the net present value of an investment.

@Ntod Converts a numeric expression into an IDEA Date
format.

@Ntot Converts a Numeric field containing time stored as
seconds to a Time field with a Time format
(HH:MM:SS).

@Pmt Calculates a loan payment.
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@Function Description

@Ppmt Returns the principal amount of a loan payment.

@Precno Returns the physical record number.

@Proper Capitalizes the first letter of each word in a string.

@Pv Returns the present value of an investment.

@Qtr Returns 1-4 representing the quarter a given date
falls in based on the specified year end.

@Random Generates a random number.

@Rate Calculates the interest rate of an investment/loan.

@Recno Returns the logical record number (index sensitive).

@RegExpr Matches character expressions using a complex set
of rules. (Not available in Unicode versions of IDEA.)

@Remove Eliminates all instances of a specified character.

@Repeat Repeats the first character of a string a specified
number of times.

@Replace Replaces a string or substring with another.

@Reverse Reverses the order of characters in a string.

@Right Isolates the specified right-most characters in a
string.

@Round Rounds to the nearest integer.

@Seconds Returns the seconds portion of a given time.

@Seed Sets the random number seed.

@SimilarPhrase Measures the similarity between two specified
phrases or Character fields.

@SimilarWord Measures the similarity between two strings (either
single words or character expressions) or Character
fields.

@SimpleSplit Extracts a segment of a character string that resides
between the specified xth occurrence of a specified
start character (or character sting) and the specified
end character (or character string).

@Sln Returns the straight-line depreciation of an asset.
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@Function Description

@Soundex Returns the sound code for a word. (Not available in
Unicode versions of IDEA.)

@SoundsLike Determines whether two words are phonetically
alike. (Not available in Unicode versions of IDEA.)

@SpacesToOne Strips spaces leaving only one space between words
in a string.

@SpanExcluding Returns the characters in a string that appear before
any characters in a specified string.

@SpanIncluding Returns the characters at the beginning of a string
that match any character of a specified string.

@Split Breaks a character string into segments separated
by characters, such as spaces or commas, and
returns a specified segment.

@Sqrt Calculates a square root.

@Str Converts numeric expressions to strings.

@Stratum Groups records by interval.

@Strip Removes all spaces, punctuation and control
characters.

@StripAccent Removes an accent from an accented character.

@Syd Returns the sum-of-years digit depreciation for an
asset.

@Time Returns the present time.

@Trim Removes trailing spaces.

@Ttoc Converts a time or number into a string with the
HH:MM:SS format.

@Tton Converts a Time field that has values stored in Time
format (HH:MM:SS) to a Numeric field with the time
value converted into seconds. This is the reverse of
@Ntot.

@Upper Converts all characters in a string to uppercase.

@Val Converts a character expression to numeric.

@Workday Returns 1 if a given date falls betweenMonday-
Friday and 0 if the date falls on a Saturday or Sunday.

@Year Returns the year in a date expression.
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